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1. Scope and purpose of this document 
Depositing and publishing data at a professional archive like AUSSDA offer several 
advantages: Most funding agencies require data management plans from applicants for 
grants which include a description of the whole research data lifecycle, from data collection 
to data archiving and sharing. Moreover, researchers who deposit their data, metadata and 
documentation material in the AUSSDA Dataverse increase the chances for receiving visibility, 
academic credit and increased citation counts.1 In addition, the AUSSDA Dataverse provides 
data with persistent identifiers (a DOI) and allows for the preservation and storage of research 
data in a way that accessibility is ensured in the future. Thereby, the research community has 
the possibility to reuse data for research or teaching and replicate results. 

Self-depositing data at AUSSDA is the fastest way for researchers to benefit from all these 
advantages of publishing data at a professional and certified repository. This document offers 
guidance on the entire self deposit process and provides detailed step-by-step instructions on 
how data and documentation material need to be prepared for self-deposit in the AUSSDA 
Dataverse. Please note that the self-deposit service is limited to quantitative data from the 
Social Sciences with a connection to Austria. Self-depositors can also find supporting 
materials at https://aussda.at/en/faq-downloads/faq/ and https://aussda.at/en/aussda-
dataverse-user-guide/. If you are interested in depositing other types of data or from other 
disciplines, please contact us, we can refer you to a suitable repository. 

If you are familiar with the individual steps of the data deposit process, you can jump directly 
to the checklist of the process to make sure that you do not miss any step (Section 6). 

2. Become an accredited self-depositor at AUSSDA and 
deposit your data. 

2.1 Get accredited! 
In order to become an accredited self-depositor at AUSSDA, read this manual and get in touch 
with us via info@aussda.at to arrange for an online training. 

• Get accredited with AUSSDA as a certified self-depositor by contacting info@aussda.at. The 
accreditation process takes 3 hours and takes place online. 

• Make sure you have taken a course on data protection basics in the last 12 months.  

2.2 The individual steps of the deposit process: an overview 
The deposit process starts with the decision to deposit data at AUSSDA and ends with the 
publication of the data. The following list provides an overview of the steps and decisions 
necessary to take for depositing data at AUSSDA. 

• Clarify the legal framework for the published data sets and documentation material. Make sure 
that you have the necessary rights to license each file according to the self-deposit agreement 
(see Section 3.2). 

 
1 https://dataverse.org  

https://aussda.at/en/faq-downloads/faq/
https://aussda.at/en/aussda-dataverse-user-guide/
https://aussda.at/en/aussda-dataverse-user-guide/
mailto:info@aussda.at
mailto:info@aussda.at
https://dataverse.org/
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• Prepare the data and documentation material for the deposit. Section 4 provides useful 
comments and processes for this step. 

• Get to know the AUSSDA Dataverse (see Section 5) by creating an entry for publishing your 
data (see Section 5.2) 

o Section 5.3 tells you more about metadata you need to add to your dataset in 
Dataverse. These steps also create a DOI for you. 

o Section 5.4 guides you through the next steps: file formats, adding the DOI and 
version as variables to the dataset, naming your files using the DOI and uploading 
everything to Dataverse. 

o The third component to every dataset is the terms (see Section 5.5). 
o After checking everything, you can publish your dataset (see Section 5.7). 
o If you need to update your dataset, see Section 5.8 on updates and versions. 

3. Legal questions 
Legal questions related to the deposit process concern three aspects:  

1. The self-deposit agreement with AUSSDA that allows depositors to self-deposit data. 
2. License agreements for data, metadata and documentation material.  
3. The AUSSDA Non-Compliance Policy and potential consequences. 

3.1. The self-deposit agreement  
In order to be authorised to self-deposit data at AUSSDA, each depositor is asked to sign an 
agreement which specifies the rights and obligations for the use of this service. This standard 
agreement is concluded once between the depositor and a legal representative of the 
University of Vienna and is the legal basis for all data deposits by this depositor. The 
agreement template is available on the AUSSDA website via:  

https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Self-
deposit_Vertrag_SU_v1_1_de.pdf 

3.2. License agreements for data, metadata and documentation material 
License agreements determine how users of the AUSSDA Dataverse can use the available data 
and documentation. Self-depositors using the AUSSDA Dataverse need to be aware of three 
licenses under which their content will be published.  

3.2.1. Metadata / CC0 
All metadata in the AUSSDA Dataverse are published under the public domain dedication 
(CC0 1.0 Universal), a license that allows for open re-use without attribution.2 

3.2.2. Documentation Material / CC BY 
All documentation material accompanying datasets (e.g. questionnaires, method reports, 
field reports or codebooks) are published open access under a Creative Commons 
Attribution 4.0 International license (CC BY 4.0). This means that documentation material is 
openly available and can be downloaded by all users of the website (after agreeing to the 

 
2 https://creativecommons.org/publicdomain/zero/1.0/  

https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Self-deposit_Vertrag_SU_v1_1_de.pdf
https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Self-deposit_Vertrag_SU_v1_1_de.pdf
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/publicdomain/zero/1.0/
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terms and conditions). A CC BY license allows for reusing and sharing the material under the 
condition that attribution is given to the original authors.3 We recommend that you include a 
notice on the licence in the documentation material (see Section 4.3). 

3.2.3. Datasets / Scientific Use 
The “License for use for scientific purposes only” (SUF) is used for all data files published by 
self-depositors.4 This licence restricts the use of the data files to scientific purposes. In 
addition, to access the data, users need not only agree to the terms and conditions, but they 
also have to identify themselves either by creating accounts or by login via their institutional 
account in the AUSSDA Dataverse.  

3.3 AUSSDA Non-Compliance Policy and potential consequences 
Users of the AUSSDA Dataverse - both when they deposit, but also when they use data - must 
agree to the AUSSDA Terms of Service5 and the AUSSDA Privacy Policy6 before using AUSSDA 
services. The AUSSDA Non-Compliance Policy7 informs both depositors and users of the 
AUSSDA Dataverse about the consequences in case of non-compliance with these terms and 
policies. In case the repository staff detects any forms of non-compliance or the repository is 
informed about the non-compliance of any of its users/depositors, AUSSDA may take certain 
measures, draw consequences according to this policy, and at the discretion of its staff.  

For you as a self-depositor, one of these forms of non-compliance that is most relevant is the 
failure to adhere to GDPR guidelines. Please refer to Section 4.1. in this manual, and read the 
Data Deposit Guidelines8 carefully to prepare your data in a GDPR compliant way. If AUSSDA 
detects any non-compliance with its terms and policies, datasets can be deaccessioned at the 
discretion of AUSSDA staff, self-depositors might be required to retake the Self-Deposit 
training and might be excluded from the service. 

 

Take aways: Legal questions 

☐ Get in contact with AUSSDA via info@aussda.at and attend the online training to become 
an accredited self-depositor. 

☐ Make sure you have taken a course on the basics of data protection in the last 12 months. 

☐ Get in contact with AUSSDA via info@aussda.at after attending the training course and 
sign the agreement that allows you to self-deposit data. 

 
3 https://creativecommons.org/licenses/by/4.0/  
4 https://aussda.at/en/contracts-and-licenses/scientific-use/  
5 https://aussda.at/en/terms-of-service/  
6 https://aussda.at/en/privacy-policy/  
7 https://aussda.at/aussda-non-compliance-policy  
8 https://aussda.at/aussda-data-deposit-guideline  

https://aussda.at/en/terms-of-service/
https://aussda.at/en/privacy-policy/
https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Non-compliance_Policy.pdf
https://aussda.at/aussda-data-deposit-guideline
mailto:info@aussda.at
mailto:info@aussda.at
https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Self-deposit_Vertrag_SU_v1_1_de.pdf
https://creativecommons.org/licenses/by/4.0/
https://aussda.at/en/contracts-and-licenses/scientific-use/
https://aussda.at/en/terms-of-service/
https://aussda.at/en/privacy-policy/
https://aussda.at/aussda-non-compliance-policy
https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA-Data-Deposit-Guideline.pdf
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☐ Understand the license agreements for data, metadata and documentation material.  

☐ Read and understand the AUSSDA Non-Compliance Policy. 

 

4. Prepare your data and documentation material 
Data are of course the centrepiece of the archiving process and hence likely require the lion's 
share of the effort preceding publication. Also have a look at our recommendations about 
documentation material(s), as comprehensive documentation accompanying the data is 
crucial for the re-usability of data. The more documentation material is made available, the 
better is the users’ understanding of the data. 

Before archiving, we recommend completing the following steps that are described in more 
detail below:  

1. Check your data for compliance with the General Data Protection Regulation (GDPR)9 and 
anonymise/pseudonymise the data (see Section 4.1) 

2. Data cleaning: double-check data for any errors, plausibility, clarity of labels and 
consistency with the documentation material (see Section 4.2) 

3. Recommended documentation material: What should be included? (see Section 4.3) 

4.1 Check compliance with the GDPR and anonymise/pseudonymise the 
data 
Since most of the studies archived with AUSSDA contain information about individuals and 
therefore comprise personal and/or sensitive information, anonymisation/pseudonymisation 
processes before the publication are inevitable. Anonymisation/Pseudonymisation protects 
research subjects against identification, fulfils the requirements of data protection, and meets 
ethical research standards. By signing the self-deposit agreement and by accepting the 
AUSSDA terms of service, self-depositors agree that the data that will be deposited will comply 
to the highest data protection standards. As hardly any raw data fulfil these criteria, carefully 
checking all variables and eventually recoding or deleting some of them is absolutely 
necessary.  
 
More detailed information on data protection guidelines is available in the Data Deposit 
Guideline10. We strongly recommend depositors to carefully read the Data Deposit Guideline 
before every publication as any violation of data protection regulations has consequences.  
 
To avoid violations of data protection we suggest taking the following countermeasures. This 
is by no means an exhaustive list:  

 
9 http://data.europa.eu/eli/reg/2016/679/oj  
10 https://aussda.at/aussda-data-deposit-guideline  

https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Non-compliance_Policy.pdf
https://www.aussda.at/aussda-data-deposit-guideline
https://www.aussda.at/aussda-data-deposit-guideline
http://data.europa.eu/eli/reg/2016/679/oj
https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA-Data-Deposit-Guideline.pdf
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Remove all direct identifiers 

Such as social security number, ID number from data collection institute, full name, 
email address, phone number, postal code, data of birth, workplace/employer, vehicle 
registration number, bank account number, IP address, student ID number, 
passport/identity card number etc11. 

Thoroughly check or delete answers to open questions 

Answers to open questions may contain detailed information of respondents that allow 
for their re-identification. Therefore, all open answers must be either deleted or 
carefully checked for any information that may violate the GDPR. 

Example 
Q: Do you have any experience in working in politics? 
A: I have been elected as delegate in the parliament for party XYZ for 12 years 
in a row.  

This information is so detailed that the respondent could be identified easily. 

Check all standard demographic variables and recode the data to broader categories if 
variables contain less than 20 observations for certain values 

Examples 
Age: aggregate to cohorts if less than 20 observations with certain age (e.g. 15-
20 years, 21-25 years, etc.) 
Nationality: categorize into groups with min. 20 observations per nationality 
(group together to regions if less than 20, e.g. according to UN geoscheme12) 
 

Although all the anonymisation/pseudonymisation steps mentioned above have to be 
completed in any case, we would like to raise awareness that the 
anonymisation/pseudonymisation steps must be adapted to the respective data and the 
context of their collection. Further processing steps must be taken, especially for sensitive 
target groups (e.g. children, minorities or victims of crimes), sensitive content (e.g. health, 
discrimination, political opinion) or where there is a higher risk of identification (e.g. if the data 
collection takes place in a small town or the target group is of public interest like members of 
parliament). 

4.2 Data cleaning  
In the following paragraphs, we outline some of the processes that proved useful for checking 
and cleaning data.  

4.2.1. Clean the data and labels 
• Check whether values are labelled clearly, correctly and consistently. For example, do 

all binary variables where the answers are “yes” and “no” show consistent labelling of 
those categories as 1 and 0? If not, label values consistently. 

• Check the accuracy of missing values.  

 
11 For more information, see Table 2 in the AUSSDA Data Deposit Guideline. 
12 https://unstats.un.org/unsd/methodology/m49/  

https://unstats.un.org/unsd/methodology/m49/
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• Spell check all variable names, labels, value labels and string variables (e.g. by 
exporting all labels to Excel and conducting a spell check) to avoid typos. 

• Check whether information is attached to the dataset that you would not like to archive 
(e.g. notes attached to the dataset or preliminary comments) and delete it if 
neccessary. 

• Scan data for unlabelled values and label them if neccessary. 
• Stata users can find useful commands in the accompanying *.do-file 

“recommended_datachecks.do” available here:  
https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA-Do-
File_Website_V2_0.do 

 

4.2.2. Compare the data and documentation material  
We recommend double-checking if all labels are assigned correctly and if the labels assigned 
in the dataset correspond to the labels in the documentation material and vice versa. Frequent 
errors are e.g. a lack of completeness and comprehensibility of labels. 

Examples 
• The variable f1_4 lists the options “don’t know“ and „not applicable“ in the dataset, but 

the codebook does not contain these options for f1_4. Check whether the data or the 
documentation material is correct. Add the missing information to the codebook or 
recode the variable in the dataset. 

• The variable capturing the respondents’ age is named “age_respondent” in the dataset, 
but “Age” in the codebook. This discrepancy requires either renaming the variable in 
the dataset or adapting the codebook.  

4.2.3. Double-check the plausibility of the data.  
We recommend checking the data for outliers and plausibility, hence, whether the observations 
are plausible.  

Example  
• If a responded is 15 or younger, he/she could not have casted a vote in the last general 

election.  
• If a respondent indicates to be single, the observation for the spouses’ occupation 

should be either missing or not applicable. 

4.2.4. Make data compatible with other formats 
Submitted data should comply to following requirements to make it easier for users of 
different analytical software to use the data. Table 1 describes technical settings in the dataset 
that you should pay attention to. 

Technical setting Reason  
System missing 
should be coded numerical (e.g. using 
negative values) instead of .a, .b 
(e.g. -99   no answer 
         -88   do not know) 

-99 is a missing value that can be displayed in 
various formats and read by different statistical 
analysis software (other than system missings 
in Stata, e.g.) 

Variable labels should not be longer Variable labels are truncated after 80 characters 

https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA-Do-File_Website_V2_0.do
https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA-Do-File_Website_V2_0.do
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than 80 characters.  
Make sure they are understandable 
and match the documentation 
material. 

in Stata and remain incomplete. They may not 
be understandable if entire questions from the 
questionnaire are saved there and are displayed 
incompletely. 

Table 1 Requirements to increase cross-software usage.  

 

Table 2 lists the recommended formats for files to be uploaded in the AUSSDA Dataverse. 
These formats guarantee accessibility for reuse of the files in the future.  

Data type Recommended formats 
data • Proprietary formats of statistical software, such as Stata (.dta), 

SPSS (.sav) 
• Free statistical software, such as R 
• Tab-, or comma-delimited text files (e.g., .csv, .tab, .tsv, etc.) 

with command file (setup/syntax for import into Stata, SPSS or 
R) 

documentation • PDF/A (.pdf)  
• Plain text, ASCII, UTF8 (.txt) 
• Hypertext Markup Language (.htm, .html) 
• JavaScript Object Notation (.json) 

images • TIFF (.tif, .tiff)  
• JPEG (.jpeg, .jpg) 
• PDF/A, PDF (.pdf) 

Table 2 Recommended formats 

4.3 Documentation material 
Comprehensive documentation accompanying the data is crucial for the re-usability of data. 
The more documentation material is made available, the better is the users’ understanding of 
the data.  

4.3.1. Mandatory documents 
The following documents are mandatory for publication with AUSSDA: 

• Data files (see Section 4.2.) 
• Documentation material; at least one of the following documents must be included: 
o Instrument of data collection (questionnaire, interviewer instructions) 
o Codebook  
o Method report 

 

4.3.2. Recommended documents 
The following documents enhance the re-usability of the data. We recommend you publish 
them if they are available:  

• Project report 
• Field report 
• Information material for respondents 
• Data collection guidelines 
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• Tabulation report 
• Data Management Plan (DMP) of project proposal  
• Interviewer guidelines 
• Interview cards  
• Documentation about incentives, contacts… 
• Recoding protocol / code and anonymisation plan  
• Informed consent form  
• Any further documents that help users to understand the data 

 

We recommend including a suggested citation and information about the license of the 
document in each document, preferably on the first page. As outlined in Section 5.3, 
documentation material is published under a CC BY license. The information on this license 
consists of two aspects: the CC BY logo can be downloaded from the Creative Common’s 
website (https://creativecommons.org/about/downloads) in several formats. The second 
aspect is a text component containing the title of the document, the information of the 
author(s), the year, and a link to the Creative Common’s website explaining the terms of the 
license https://creativecommons.org/licenses/by/4.0/.  

Below, you find an example how this information can look like: 

 Questionnaire for the EOSC-Pillar “National Initiatives” Survey by 
Anita Bodlos, Lisa Hönegger, Lars Kaczmirek, Volker Beckmann, Vincent 
Breton, Geneviève Romier, Jos van Wezel, Achim Streit, Uros Stevanovic, 
Fulvio Galeazzi, Federica Tanlongo, Inge Van Nieuwerburgh (2020) is 
licensed under a Creative Commons Attribution 4.0 International Licence. 
 

 

Take aways: Prepare data and documentation material 

Compliance with GDPR 

☐ I removed all direct identifiers from my data. 

☐ I checked all answers to open questions and removed personal or sensitive data, or 
deleted the variable(s). 

☐ I recoded standard demographic variables to broader categories if variables contain less 
than 20 observations for certain values and updated the codebook with these new categories. 

Data cleaning 

☐ I cleaned the data as suggested, e.g. regarding variable and value labels and missing 
values, among others. 

☐ I gathered all documentation material (questionnaires, codebooks, method report, 
anonymisation plan, ...) for my data. 

https://creativecommons.org/about/downloads
https://creativecommons.org/licenses/by/4.0/
http://creativecommons.org/licenses/by/4.0/
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5. Self-depositing your data in the AUSSDA Dataverse 
The following pages contain some general information and a detailed step-by-step guide for 
uploading your data in Dataverse and finally publishing your work.  

General information about the AUSSDA Dataverse 

AUSSDA Dataverse is the digital archive of AUSSDA - The Austrian Social Science Data Archive. 
It is based on the open-source application Dataverse which has been developed by Harvard 
University.  

We also use the term Dataverse to describe subfolders in the AUSSDA Dataverse – the Self-
Deposit Dataverse then is a “folder" for researchers, projects or journals to share and make 
their data available. The Self-Deposit Dataverse contains all datasets curated and published 
by accredited self-depositors. A dataset consists of: 

1. Metadata (Section 5.3) 
2. Files (Section 5.4) 
3. Terms (Section 5.5) 

Below we will guide you through entering your metadata, data and documentation in the Self-
Deposit Dataverse, starting with metadata. We recommend that you read the entire section on 
metadata (5.3) and prepare all metadata accompanying your dataset (see Table 3) before you 
actually create a dataset entry and start entering the metadata in Dataverse. 

Please be aware that the working language in our Dataverse is English.  

 
Important things to consider when self-depositing data in the AUSSDA Dataverse 

• Some settings in Dataverse are set by AUSSDA and cannot be changed: Metadata 
fields that are marked as “required” need to be filled in (see section 5.3 for more 
details). 

☐ I compared the data with the documentation material and checked if the value labels 
match. If not, I corrected all discrepancies. I checked for typos in the variable names and 
corrected them. 

☐ I double-checked the data with regard to plausibility and outliers and they are fine. 

Documentation material 

☐ I double-checked if I have all mandatory documentation material. I also know which 
recommended documents I want to upload. 

☐ I included a suggested citation and information about the license of the document in each 
document, preferably on the first page. 
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• Also, the settings in the Self-Deposit Dataverse allow all logged-in users to download 
account-based scientific use (SUF) files.  

• Be aware that after you have published your dataset it cannot be deleted. If you 
discover a grave error, please contact us immediately. Together, we can devise a plan 
of action. In the worst case, this may include deaccessioning your dataset so that users 
cannot access the uploaded files anymore. A reason for deaccessioning your dataset 
would be if a high risk of identification of data subjects existed. However, the metadata 
of your study, including the DOI, will always be findable13, openly available and 
harvested by other data catalogues. 

• Other self-depositors in the Self-Deposit Dataverse can see and edit your drafts. Please 
edit your personal drafts only. 

5.1 Login  
Go to “data.aussda.at”. 

Click “Log in” or “Sign Up”. 

There are two forms of registration: You can either register a local account under “Sign up” or 
use your institution’s login data under “Log in” (Figure 1).  

 
Figure 1 Dataverse Log in and Sign up. For video instructions go to the AUSSDA User guide14. 

5.1.1. Log In 
Choose your institution from the list and log in using your institutional credentials. If you 
choose institutional login, look for the English name of your institution in the list. Under Log In 
you can also log into your local AUSSDA Dataverse user account. If you encounter any 
problems, please contact us. 

5.1.2. Sign Up  
If you do not want to or cannot use institutional login, you can create a local account in our 
AUSSDA Dataverse. Please be aware of the password requirements: Your password must 

 
13 Refer to CESSDA’s PID Policy if you want to know more about why metadata are still available after 
deaccessioning (https://doi.org/10.5281/zenodo.3611327).  
14 https://aussda.at/en/userguide/  

https://data.aussda.at/
https://aussda.at/en/userguide/
https://doi.org/10.5281/zenodo.3611327
https://aussda.at/en/userguide/
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1) be at least 8 characters long and 2) contain at least 1 character from 3 of the following 
types: uppercase, lowercase, numeral, special. If your password is longer than 20 characters, 
requirement 2) does not apply. The next time you visit our Dataverse, you can use that 
username and password to access your account under “Log in”.  

If this is your first self-deposit and you have just completed the accreditation process at 
AUSSDA please send the AUSSDA Team a quick message via info@aussda.at including your 
username so they can add you to the Self-Deposit Dataverse. 

Take aways: Login 

 

5.2 Create a Dataverse entry 
Go to the “Self-Deposit Dataverse”.15 

On the right, middle side of the page, click „+ Add Data“ > “New Dataset” (see Figure 2).  

If you cannot see this button, please contact us.  

 
Figure 2 Adding a „New Dataset“ to the “Self-Deposit Dataverse”. 

On the new page (see Figure 3), keep “Host Dataverse”, Self-Deposit is correct and 
choose “Self-deposit (SUF terms)” as your dataset template.  

Now, you can already scroll down and click “Save Dataset” and add all metadata and 
files later. In this case, a DOI is registered immediately via DataCite16, and all required 

 
15 https://data.aussda.at/dataverse/self-deposit  
16 This means this DOI is reserved for your dataset and remains the same also after publishing.  

☐ I logged into the AUSSDA Dataverse on https://data.aussda.at/. 

☐ I sent a message to info@aussda.at including my username so they can add me to the 
Self-Deposit Dataverse. 

mailto:info@aussda.at
https://data.aussda.at/dataverse/self-deposit
https://data.aussda.at/dataverse/self-deposit
https://data.aussda.at/
mailto:info@aussda.at
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metadata fields are prefilled with placeholders. If you want to add metadata 
immediately, continue with Section 5.3. and stay on this page. 

 
Figure 3 Use the Self-Deposit template, and either save a draft now or continue to enter all your 

metadata. 

 

Take aways: Create a Dataverse entry 

 

5.3. Metadata 
Metadata - data about data - describe available data resources to facilitate searching for and 
cataloguing of data. Open and unrestricted access to metadata is essential for effective data 
use and re-use. Therefore, metadata in the AUSSDA Dataverse are published under the public 
domain dedication (CC0 1.0 Universal) and may thus be freely and openly accessed and used 
by the public. This, and other measures, make your data Findable, Accessible, Interoperable 
and Re-usable (FAIR). The description of the deposited data follows international standards 

☐ I navigated to the AUSSDA Self-Deposit Dataverse and started to add a new Dataverse 
entry by clicking on “+ Add Data“ > “New Dataset”. 

☐ I used the “Self-deposit (SUF terms) template to benefit from pre-filled fields.  
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set by the Data Documentation Initiative (DDI)17 and the Consortium of European Social 
Science Data Archives (CESSDA ERIC)18. If you want to know more about what is behind 
metadata, please refer to the AUSSDA Metadata Guide19. 

5.3.1. Metadata table with examples 
Table 3 gives an overview over the different metadata fields. The table also presents some 
examples and contains a column that serves as a checklist. We provide links to the related 
vocabularies in the text and the footnotes. Ideally, you collect this information during the 
research process, and before you create your Dataverse entry. You can use the AUSSDA 
metadata template20 to collect your metadata. (This file also contains the links and 
descriptions in the table below). 

You can find an example of a dataset in the AUSSDA Dataverse here: 
https://doi.org/10.11587/8SFV2L.  

 

  

 
17 https://ddialliance.org/  
18 https://www.cessda.eu/  
19 https://aussda.at/aussda-metadata  
20 https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Metadata_v2_1.xlsx 

https://aussda.at/aussda-metadata
https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Metadata_v2_1.xlsx
https://data.aussda.at/dataset.xhtml?persistentId=doi:10.11587/QDETRI
https://ddialliance.org/
https://www.cessda.eu/
https://aussda.at/aussda-metadata
https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Metadata_v2_1.xlsx


 

 
 

Metadata item Description Example Yeah, I got 
this! 

Study title *21 Full title of the dataset. Your title (SUF edition)  

Author * This is part of how the data set will be cited, so the order of 
person(s)/author(s) is relevant. Add every person/author's family name, 
given name or the name of the organization responsible for this dataset as 
well as the organization with which the person/author is affiliated. In case 
you have one, you can also provide us with your ORCID (which is a 
persistent digital identifier (PID) that distinguishes researchers from each 
other and ensures that your research work is recognized).  

Random, Jane (University of Vienna) 
ORCID 123456 

 

Abstract * An abstract describing the purpose, nature, and scope of your dataset.   

Keywords *22 This field contains English keyword terms that describe important aspects 
of the dataset. We use ELSST. You can select up to 14 keywords to 
describe your dataset. Please do not use entry terms. If you need more 
keywords, try to choose broader concepts. If you cannot find a keyword in 
ELSST, make sure that your abstract contains this term to make it findable 
in Dataverse. Do not use all capital letters when entering your metadata 
into Dataverse (see examples). 

Trust in government 

Elections 

Politics  

Topic 
Classification*23 

Topics from the Topic Classification indicate the broad important topic(s) 
and subjects that the data cover. We use the CESSDA Topic Classification. 
You can use up to 7 topics to describe your dataset. 

Public health 

Censuses 

Education 
 

Related Publication Related publication(s) connected to the dataset, e.g. journal articles, 
monographs, chapters in books (with doi/ISBN/ISSN/Isid or other 
persistent id). 

Author’s Last name, F. M. (Year 
published). Article title. Periodical 
Title, Volume(Issue), pp.-pp. doi: 

 

 
21 Asterisks indicate required fields * 
22 https://elsst.cessda.eu/id/ 
23 https://vocabularies.cessda.eu/urn/urn:ddi:int.cessda.cv:TopicClassification:4.2.2?lang=en  

https://elsst.cessda.eu/id/
https://vocabularies.cessda.eu/urn/urn:ddi:int.cessda.cv:TopicClassification:4.2.2?lang=en
https://elsst.cessda.eu/id/
https://vocabularies.cessda.eu/urn/urn:ddi:int.cessda.cv:TopicClassification:4.2.2?lang=en


   

   
 

Metadata item Description Example Yeah, I got 
this! 

10.01234/ABC4E. 
(https://doi.org/10.01234/ABC4E) 

Language * The language(s) of your dataset(s). German, English  

Grant information: 
Grant agency and 
grant number 

This is the name of the agency and the grant or contact number that 
provided funding/sponsored the effort. 

H2020: FA123456  
 

Date of collection: 
Start * 

This field describes the date when the data collection started in the format 
YYYY-MM-DD. If you are collecting data in multiple waves, we recommend 
that you add the very first start date and the last end date of your data 
collection period. 

2023-10-22 

 

Date of collection: 
End * 

This is the date when the data collection ended in the format YYYY-MM-DD. 2024-03-30 
 

Kind of Data *24 Describes the kind of data included in your data file. Possible options are: 
Numeric, Text, Still image, Geospatial, Audio, Video, Software, Interactive 
resource, 3D, other.  

See descriptions here: Controlled vocabulary Kind of Data 

Numeric; Text 

 

Type of Data 
Sources *25 

This field contains information on the type of your data sources. These 
could be: Population group (for surveys), Communication: Public (for press 
releases), Research data, Registers/records/accounts, Other, etc. Please 
note that “Research data” should only be chosen if your data relies on pre-
existing research data (e.g. you merge or combine research data). 

The full list can be found here: Controlled vocabulary Data Sources.  

Population group 

 

Geographic 
Coverage * 

This field contains information on the geographic coverage of your data. 
For example: AT (for Austria); Vienna, AT; Luftenberg, Oberösterreich, AT.  

Graz, Austria 
 

 
24 https://vocabularies.cessda.eu/vocabulary/GeneralDataFormat?v=2.0.3&lang=en 
25 https://vocabularies.cessda.eu/vocabulary/DataSourceType?v=1.0.2&lang=en 

https://vocabularies.cessda.eu/vocabulary/GeneralDataFormat?v=2.0.3&lang=enl
https://vocabularies.cessda.eu/vocabulary/DataSourceType?v=1.0.2&lang=en
https://ddialliance.org/Specification/DDI-CV/KindOfDataFormat_1.0.html
http://www.ddialliance.org/Specification/DDI-CV/DataSourceType_1.0.html


   

   
 

Metadata item Description Example Yeah, I got 
this! 

Unit of Analysis 
Type *26 

Describes the basic unit of analysis or unit of observation in your dataset. 
Choose from terms such as Individual, Family, Household, Media unit: Text, 
Media unit: Still image, Organization/Institution, Other, etc. 

See descriptions here: Controlled vocabulary Unit of Analysis 

Individual 

 

Universe Description of the population covered by your dataset; the group of people 
or other elements that are the object of the study and to which the study 
results refer to. Age, nationality, and residence commonly help to delineate 
a given universe, but any number of other factors may be used, such as age 
limits, sex, marital status, race, ethnic group, nationality, income, veteran 
status, criminal convictions, and more. The universe may consist of 
elements other than persons, such as housing units, court cases, deaths, 
countries, and so on. This term is also known as the universe of interest, 
population of interest, and target population. 

Austrian resident population from 
age 14 

 

Time Method *27 Describes the time method or time dimension of the data collection, such 
as Longitudinal, Longitudinal: Trend/Repeated cross-section, Longitudinal: 
Panel, Time series, Cross-section, Other. 

The full list can be found here: Controlled vocabulary Time Method 

Longitudinal: Panel 

 

Sampling 
Procedure*28 

This field contains the type of sample and sample design used to select the 
survey respondents to represent the population. Choose from terms such 
as Total universe/Complete enumeration, Probability, Probability: Stratified, 
Non-probability, Non-probability: Quota, Mixed probability and non-
probability, Other. 

The full list can be found here: Controlled vocabulary Sampling Procedure 

Non-probability: Quota 

 

 
26 https://vocabularies.cessda.eu/vocabulary/AnalysisUnit?v=2.1.3&lang=en 
27 https://vocabularies.cessda.eu/vocabulary/TimeMethod?v=1.2.0&lang=en 
28 https://vocabularies.cessda.eu/vocabulary/SamplingProcedure?v=1.1.0&lang=en 

http://https/vocabularies.cessda.eu/vocabulary/AnalysisUnit?v=2.1.3&lang=en
https://vocabularies.cessda.eu/vocabulary/TimeMethod?v=1.2.0&lang=en
https://vocabularies.cessda.eu/vocabulary/SamplingProcedure?v=1.1.0&lang=en
http://www.ddialliance.org/Specification/DDI-CV/AnalysisUnit_1.0.html
https://vocabularies.cessda.eu/vocabulary/TimeMethod?v=1.2.0&lang=en
https://vocabularies.cessda.eu/vocabulary/SamplingProcedure?v=1.1.0&lang=en


   

   
 

Metadata item Description Example Yeah, I got 
this! 

Method of Data 
Collection *29 

Describes the method used to collect your data, such as Telephone 
interview: CATI, Self-administered questionnaire: Web-based (CAWI), Focus 
group, Content coding, Transcription, Compilation/Synthesis, Automated 
data extraction: Web scraping, Other. 

The full list can be found here: Controlled vocabulary Method of Data 
Collection 

Self-administered questionnaire: 
Web-based (CAWI) 

 

Type of Research 
Instrument *30 

Describes the type of data collection instrument used to collect your data, 
such as Questionnaire, Structured questionnaire, Interview scheme and/or 
themes, Data collection guidelines, Programming script, Other. 
 
The full list can be found here: Controlled vocabulary Type of Research 
Instrument 

Structured questionnaire 

 

Table 3 Metadata 

 
29 https://vocabularies.cessda.eu/vocabulary/ModeOfCollection?v=4.0.0&lang=en 
30 https://vocabularies.cessda.eu/vocabulary/TypeOfInstrument?v=1.1.0&lang=en 

https://vocabularies.cessda.eu/vocabulary/ModeOfCollection?v=4.0.0&lang=en
https://vocabularies.cessda.eu/vocabulary/ModeOfCollection?v=4.0.0&lang=en
https://vocabularies.cessda.eu/vocabulary/TypeOfInstrument?v=1.1.0&lang=en
https://vocabularies.cessda.eu/vocabulary/TypeOfInstrument?v=1.1.0&lang=en
https://vocabularies.cessda.eu/vocabulary/ModeOfCollection?v=4.0.0&lang=en
https://vocabularies.cessda.eu/vocabulary/TypeOfInstrument?v=1.1.0&lang=en
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5.3.2 Tips and Tricks for dealing with metadata 
Here are some general tips for filling the metadata:  

• Collect metadata during the research process in the AUSSDA metadata template31. Then 
you can easily transfer the information into the Dataverse entry you created when you 
need to.  

• Some fields are prefilled in the template. In Table 3, you can find more information where 
you need to replace information and where no changes are needed. 

• Required fields that you need to fill are marked with a red asterisk *. In case you do not 
have this information, or it is not applicable to you, fill the field with “n/a”. 

• Do not use thousands separators, as they may cause problems when metadata are 
harvested by other data catalogues. For example, instead of writing “12,300 participants 
answered the survey”, do not use the separator and add the text “12300 participants 
answered the survey”.  

• When using controlled vocabularies, try to pick the terms that fit your data. If you are not 
sure which category of a controlled vocabulary applies, choose a broader category, i.e. a 
higher-level term. For example, if you are unsure whether structured or semi-structured 
questionnaire fits your data better when filling out the metadata field for “Type of 
Research Instrument”, pick the broader category “questionnaire”. 

• We recommend checking for and eventually correcting trailing blanks (a space after the 
last digit) and spelling errors.  

Here are some general tips for working with ELSST – The European Language Social Science 
Thesaurus: 

• In ELSST (https://thesauri.cessda.eu/elsst/en/) you can either search for a term you 
would like to use as a keyword, but you can navigate on the left side by either scrolling 
alphabetically or in the hierarchical view as well.  

• Please choose from preferred terms, broader or narrower or related concepts (clickable 
terms). Other terms, like entry terms, should not be used to index your dataset.  

• In the example in Figure 4 the search word was “political science”. As this is an entry term, 
the user has been forwarded to the preferred term “Politics”. 

• Choose a maximum of 14 keywords. If you need more, try to choose a broader concept. 
• When entering the “Term” in Dataverse, do not use all capital letters. See examples in 

Table 3.  
• If you cannot find a keyword in ELSST, add the term to your abstract text to make it 

findable in Dataverse.  

 
31 https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Metadata_v2_1.xlsx 

https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Metadata_v2_1.xlsx
https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Metadata_v2_1.xlsx
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Figure 4 Controlled vocabulary for Keywords: ELSST. 

 

 

 

Here are some general tips for working with CESSDA Controlled Vocabularies: 

• Each of the CESSDA controlled vocabularies (see links in Table 3)  has its own website 
including a table with three columns. The terms we use are in the middle column, named 
“Code descriptive term (en)”. In the column on the right, you can see a description of each 
term (“Code definition (en)”). 

• Try to find the most narrow term that fits your project (for example “Face-to-face interview: 
Paper-and-pencil (PAPI)” in Figure 2, and move to broader terms if you cannot find a fitting 
one: Choose the broader term “Face-to-face interview” if neither of the narrower terms 
“Face-to-face interview: Computer-assisted (CAPI/CAMI)” or “Face-to-face interview: 
Paper-and-pencil (PAPI)” fit.  
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Figure 5 Example of a controlled vocabulary. 

5.3.3 Save and edit your Dataverse entry  
If you have not saved your Dataverse entry before, do it now after you have entered all your 
metadata. Upload your data and documentation files later as they still need some changes 
outlined below in Section 5.4. 

Click „Save” as a next step. A DOI is immediately registered via Datacite. 

You can revise and edit your metadata at a later point in time as well. 

 
Figure 6 Edit your dataset in Dataverse. 

In Figure 7 you can see how your dataset draft looks like after saving the required metadata. The 
“Edit” button in the right corner is very important. There, you can  

1) Upload and restrict files: “Files (Upload)” (see Section 5.4.). 
2) Add additional information: “Metadata” (see next topic below, 5.3.4). 
3) Check and edit the Terms of Use and Terms of Access: “Terms” (see Section 5.5.). 
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4) Delete your dataset draft (learn more about this and publishing in Section 5.6). 

5.3.4. Add additional Metadata 
Click on “Edit” > “Metadata” to edit metadata and add additional metadata. 

If you have not added any metadata yet and came here directly from Section 5.2., add all 
metadata. If you have already added metadata, you can now see additional fields that are not 
mandatory for a deposit that have not been shown to you when you have created the Dataverse 
entry. 

Some fields you could add now are:  

• Alternative title: In case your dataset originally has a German title, use this field to enter 
the German name of your dataset here.  

• Contributor(s): You can select different types of contributor(s) to the data set. It is 
possible to mention data curator(s), data collector(s), researcher(s) here. You can add 
more contributors with the "+" button. This is not necessary to add a contributor here, 
when they have already been mentioned as author of the data. 

Click “Save changes”. 

 

Take aways: Metadata 

☐ I collected all relevant metadata and saved the information in the AUSSDA metadata 
template. 

☐ I understand what controlled vocabularies are and selected the fitting terms for my dataset. 

☐ I entered all metadata in Dataverse. 

 

5.4. Files in Dataverse: Add your documentation and data 
In this section, we outline in detail the necessary steps for preparing the data and documentation 
material to upload them in the AUSSDA Dataverse.32 This includes: 

• Saving DOI and version as variables in the dataset 
• File formats 
• File naming 
• Uploading files in Dataverse 

 

5.4.1. Save the DOI and the version as variables in the dataset 
You need to add the DOI of the dataset and the version as variables in the dataset. Thereby, 
users can see which version they use in their analyses at a glance and can cite the data easily.  

 
32 See also the Data Deposit Guideline. 

https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA-Data-Deposit-Guideline.pdf
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Figure 7 You can find the DOI of your Dataverse entry in the blue citation field and in the tab “Metadata”. 

  Please note the last 6 digits as suffix of the DOI. 

  Add the variable version to your dataset. 

• variable name: version 
• content: “vmajor.minor (YYYY-MM-DD)”, example “v1.0 (2020-08-26)” 
• variable label (or variable name in R): "AUSSDA archive version" 

  Add the variable doi to your dataset. 

• variable name: doi  
• content: “doi:10.11587/ABC123” 
• variable label: "digital object identifier" 

As the DOI is generated after creating and saving the Dataverse entry, we recommend that these 
steps are done right before the upload of the dataset. This allows you to upload the most recent 
version of the dataset. We recommend ordering the version and the DOI as the first variables of 
the dataset.33 

 

5.4.2. File formats 
During the upload, Dataverse automatically generates a tab-delimited version of many data files, 
also of Stata and SPSS-files. This processing is called “ingest” and takes some time. You will 
receive an e-mail after the processing is complete. When clicking the “Download” button, the 
original file format is still the first download option for users, open formats are provided for usage 
in other software. By conversion to *.tab-format, long-term re-use is secured. For more details on 
this topic and how Dataverse treats other formats, please see the Dataverse user guide34. 

 

 
33 You can find assisting syntax scripts for these steps here: https://www.aussda.at/en/faq-downloads/  
34 http://guides.dataverse.org/en/latest/user/tabulardataingest/index.html  

http://guides.dataverse.org/en/latest/user/tabulardataingest/index.html
https://www.aussda.at/en/faq-downloads/
http://guides.dataverse.org/en/latest/user/tabulardataingest/index.html
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Documentation 

We recommend saving the documentation material as PDF/A, a secure long-term format. You 
can find step-by-step instructions here35 (German), here36 (English) or here37 (English). These 
are different solutions depending on the software you use. 

Data  

Please upload your data in the AUSSDA Dataverse as SPSS (*.sav), Stata (*.dta), R (*.rdata or 
*.rds), or comma-separated-value (*.csv). We recommend using the unicode format for all files 
and to avoid diacritics if possible. 

For Stata users 

We recommend saving Stata files as unicode which is the default file format since Stata 
14 and users may not always have the most recent version of Stata at their disposal. 

For SPSS users 

We recommend running SPSS in unicode mode (default mode since SPSS version 21), 
data files will then be stored in unicode encryption.38 

For Excel users 

Do not use Excel as a data format, we recommend saving datasets as *.csv (UTF-8 
encoded):  

Go to “File” -> “Save As” -> select “CSV UTF-8 (comma delimited) (*. csv)” 

If it is necessary to publish Excel files, please double zip the file before uploading. 
Dataverse processes Excel files but will produce errors, when there are multiple sheets 
and connected cells. 

For the best reuse of your data, we recommend storing your data also in non-proprietary file 
formats that are used by the community, e.g. in *.csv used by R-users. If you want to learn more, 
do not hesitate to contact us. 

AUSSDA encourages you to use the recommended file formats to enhance re-use of data. Using 
the recommended formats also ensures that your files are secured long-time as they are fully 
compatible with our long-time archival and preservation strategy. Check section 4.2.4 again for 
more information. 

 

5.4.3. File naming 
Please use the AUSSDA file naming scheme which enables users to quickly understand the 
content of the files and also makes the file names consistent over different data deposits. 
Dataverse does not accept files with identical names which makes the usage of our AUSSDA file 
naming scheme crucial. We recommend avoiding any blanks, diacritics or uppercase letters in 
filenames. 

Name the files using the following pattern:  

DOIsuffix_description_language_version.fileExtension  

 
35 https://zid.univie.ac.at/computer-rooms/anleitungen/pdfa-erstellen/  
36 https://library.princeton.edu/special-collections/sites/default/files/Creating_PDFA.pdf  
37 https://blogs.adobe.com/acrolaw/2011/05/using-save-as-to-to-conform-to-pdfa/  
38https://www.ibm.com/support/knowledgecenter/en/SSLVMB_26.0.0/statistics_mainhelp_ddita/spss/b
ase/faq_unicode.html  

https://zid.univie.ac.at/computer-rooms/anleitungen/pdfa-erstellen/
https://library.princeton.edu/special-collections/sites/default/files/Creating_PDFA.pdf
https://blogs.adobe.com/acrolaw/2011/05/using-save-as-to-to-conform-to-pdfa/
https://zid.univie.ac.at/computer-rooms/anleitungen/pdfa-erstellen/
https://library.princeton.edu/special-collections/sites/default/files/Creating_PDFA.pdf
https://blogs.adobe.com/acrolaw/2011/05/using-save-as-to-to-conform-to-pdfa/
https://www.ibm.com/support/knowledgecenter/en/SSLVMB_26.0.0/statistics_mainhelp_ddita/spss/base/faq_unicode.html
https://www.ibm.com/support/knowledgecenter/en/SSLVMB_26.0.0/statistics_mainhelp_ddita/spss/base/faq_unicode.html
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Example: ABC123_mr_en_v1_0.pdf 
 

DOIsuffix 

A DOI consists of the prefix (in the case of AUSSDA, the prefix is 10.11587), followed by a slash 
(“/”) and a 6-digit suffix. Hence, the suffix is the combination of letters and numbers in the DOI 
after the “/” (e.g. in the DOI 10.11587/ABC123, “ABC123” is the suffix). As these 6 digits of the 
suffix are unique to your dataset, use them to name all your files. You can find the DOI that has 
been reserved for you in several places in Dataverse (example: as part of the citation box at the 
top in Figure 7). 

description 

AUSSDA usually uses two letters for describing the content of a file. The conventionally used 
abbreviations of the content of files are shown in Table 4.  

If you upload more than one file per category (e.g. two codebooks), we recommend adding 
numbers after the abbreviation (e.g. ABC123_co01_en_v1_0.pdf and ABC123_co02_en_v1_0.pdf).  

language 

AUSSDA conventionally uses two letters for abbreviating the language in filenames for 
documentation material or datasets. The most frequently used abbreviations are “de” for German 
and “en” for English. Follow the ISO 693-1 code39 if you need abbreviations for other languages. 

version 

The version is usually preceded by the letter “v”. We recommend using major and minor versions 
that are separated by underscores (“_”) rather than a full stop (“.”). E.g. “version 1.1” is given in 
the style “v1_1”.40 

 

Abbreviation  English description  German description  
da data Daten 
qu Questionnaire Fragebogen 
im Interviewer manual Interviewerhandbuch 
fr Field report Feldbericht  
co Codebook Codierliste 
rr Research report Forschungsbericht 
mr Method report Methodenbericht 
sx Code / syntax Code / Syntax 
ta Tabulation report Tabellenband 
om Other material, specify in 

Dataverse description 
anderes Material 

vi Variable identifiers and 
descriptions 

Variablenidentifikation und -
beschreibung 

Table 4 Descriptions and abbreviations used for the file names of documentation material 

 
39 https://de.wikipedia.org/wiki/Liste_der_ISO-639-1-Codes  
40 Major changes in data and documentation lead to a major version change (e.g. replaced variables), 
whereas minor changes in the files (e.g. like correction of typos) lead to minor version changes.  

https://de.wikipedia.org/wiki/Liste_der_ISO-639-1-Codes
https://de.wikipedia.org/wiki/Liste_der_ISO-639-1-Codes
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Documentation 

Example 1 After creating the Dataverse entry, the DOI “10.11587/ABC123” is created. The file 
name for version 1.0 of the questionnaire in English is ABC123_qu_en_v1_0.pdf. 

Example 2 After creating and saving the Dataverse entry, the DOI “10.11587/DEF456” is created. 
You have two German and two English method reports. The file names for the English version 1.0 
of your method report are DEF456_mr01_en_v1_0.pdf and DEF456_mr02_en_v1_0.pdf. The file 
names for the German method reports are DEF456_mr01_de_v1_0.pdf and 
DEF456_mr02_de_v1_0.pdf. 

Data 

Example 1 Imagine, you have one German and one English Stata dataset that are identical besides 
the language. After creating and saving the Dataverse entry, the DOI “10.11587/GHI789” is 
created. The file name for the English version 1.0 of your data is GHI789_da_en_v1_0.dta and for 
the German data GHI789_da_de_v1_0.dta.  

Example 2 After creating and saving the Dataverse entry, the DOI “10.11587/JKL123” is created. 
You have two English SPSS datasets. The file names for the English version 1.0 of your datasets 
are JKL123_da01_en_v1_0.sav and JKL1236_da02_en_v1_0.sav.  

Take aways: DOI, version, file formats and file names 

 

5.4.4. Upload Files 
Next, you can upload your files to your dataset draft. 

 Click on “Edit” > “Files (Upload)” as shown in Figure 7. 

☐ I added the variables “DOI” and “version” to my dataset. 

☐ I saved my documentation material as PDF/a. 

☐ I named my data files according to the AUSSDA file naming scheme. 

☐ I generated other file formats to increase the reuse potential. 
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Figure 8 Add files, file metadata and restrictions in Dataverse.  

Select or drag and drop all files you want to upload and make available to users.  

Add more information about your files (also called “file metadata”): It consists of the 
“File Name” following the AUSSDA file naming, a “File Path”, a short “Description” of the 
content of the file and “Tags”.41  

• File Name: You can find information about file naming in the section above. 
• File Path: Use either “data” or “documentation”, depending on the file. 
• Description: Use a short descriptive text to describe the content of your file following the 

information in Table 4: 
• Examples 

o Codebook 
o Method report  
o Core data file – STATA format – XXX variables, YYY observations 

Add more information to your files and add Tags as shown in Figure 10. 

 
41 „File Name“ and „Description“ are required fields. 
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Figure 9 Add tags to a file to describe your file in more detail. 

 

• Click on the three dots to the right-hand side to further edit file options. 
• Choose the tags that fit your file from the drop-down menu under File Tags. Please make 

sure to always use the tags “data” for data files and “documentation” for documentation 
files.  

• Click “Save changes” to save the tags for the selected file, and repeat for all other files. 

Click “Save changes” again to save all changes (uploaded files and file metadata). 

 

5.4.5. File Restrictions 
Now, you need to restrict the data files in your Dataverse entry according to the Self-Deposit 
agreement. File restrictions allow you to choose who has access to files. Usually, data files in the 
Self-Deposit Dataverse are licensed under a scientific use license, and are made available on an 
account based basis. This means that only users who are logged in to the AUSSDA Dataverse can 
download them. Documentation material on the under hand is licensed under a CC BY license, 
and available to users who are not logged in as well.  

In the “File” tab in Dataverse, check the checkbox on all files that will be provided under 
the scientific use licence (i.e. the data files).  

Click on “Edit”.  

Click on “Restrict” to restrict your data files.  

Check the “Enable Access Request” checkbox. This allows users who are logged in to 
access the files. 

Click “Save Changes”. 
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If you see a green, open lock next to the file thumbnail, the restriction is in place. Users 
who are not logged in will see a red, closed red lock. The green lock shows that the data 
file is available for logged in users.  

 

 
Figure 10 In the tab “Files” you can edit file metadata, restrict or delete files and add tags.  

Wait until Dataverse has processed your data files. Dataverse will automatically try to 
convert your data files to *.tab format which can take up to a few hours. While Dataverse 
processes your data files, you cannot edit the dataset entry. 

Cross-check the numbers of variables and observations that are shown in the technical 
metadata with the numbers you added in the description (Figure 11). If they do not 
match, double-check you put the correct numbers in the description and contact us if the 
discrepancy remains.  

 
Figure 11 An uploaded file has a filename, technical metadata (grey font), a description (black font), tags 

and restrictions set in place (red lock).  

 

Take aways: Upload files and file restrictions in Dataverse  

☐ I uploaded all data files in the recommended formats and documentation files in PDF/a. 

☐ I added a file path, description and tags to each file.  

☐ I restricted all my data files and confirmed that I can see a green, open lock next to the file 
name. 
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5.5. Terms 
In the “Terms” tab in Dataverse, have a look at the terms. The “Terms of Use” may not be 
changed as they stem from the agreement you signed with AUSSDA and are part of the 
template you used to create your Dataverse entry (Figure 12.)  

 
Figure 12 Terms of Use. 

Scroll down and check if the number of “Restricted Files” matches the number of data 
files you uploaded and restricted in Section 5.4.5. 

The “Terms of Access for Restricted Files” should look like displayed in Figure 13.  

Check if the text “Users may request access to files” appears next to “Request access”. 

 
Figure 13 Terms of Access with enabled access request. 

Take aways: Terms 

 

  

☐ I checked the “Enable access request” checkbox for all data files.  

☐ I checked if the Terms of Use and Terms of Access are indeed pre-filled. 

☐ I checked if the number of restricted files corresponds to the number of data files. 
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5.6 (optional) Delete drafts 
It is possible to delete your draft before it has been published, if you really do not need it anymore. 
It cannot be restored once deleted (see Figure 15). If you delete your draft, your DOI is irrevocably 
deleted. 

Click “Edit”. 

Click “Delete Dataset”. 

Confirm by clicking “Continue”. 

 
Figure 14 Deleting a dataset draft. 

5.7. Publishing  
In this section you learn more about publishing your draft entry.  

Your draft is now finished, congratulations!  

Thoroughly check your dataset in Dataverse before the publication. 

If this is your first upload, click “Submit to Review”. Then the AUSSDA Team gives 
feedback on the metadata and your Dataverse entry in general. You will not be able to 
make any changes while the dataset is under review. AUSSDA will get back to you with 
feedback. If the draft is ready to publish, your account will get the rights to do so. 

Click “Submit for Review” or “Publish”. 

Confirm by clicking “Continue” (See Figure 15). 

 
Figure 15 Submitted for Review 
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If this is not your first data deposit, you can publish right away. 

Publishing a dataset may take some time as Dataverse processes your data files, so please be 
patient. For any publish, if you do not get a “Success” message at the top of the page, please 
contact us with further details and a screenshot of the error message. Published datasets remain 
published and accessible via the DOI. 

Take aways: Publishing 

 

5.8. Updates 
If you want to upload additional files or discover that you forgot to add any important metadata, 
you can update your existing Dataverse entry. The DOI will stay the same. 

As soon as you edit something in an already published Dataverse entry, Dataverse creates a new 
“draft” version of your Dataverse entry (see Figure 16). Previous versions including all files always 
remain unchanged and accessible for users (see tab “Versions” in Figure 17).  

 
Figure 16 Draft vs. Published versions in Dataverse. 

Change the versioning in the names of your files if you uploaded new data and 
documentation files (see Section “5.4.3”). If you only updated metadata, you do not need 
to change the versioning of your files. 

Click „Publish“. 

Decide on the version change of your Dataverse entry that is part of the citation. If you 
upload new files or deleted files, the version automatically increases by a full number 
(Figure 16), e.g. from V1 to V2. If you only update metadata, you can decide whether 
Dataverse increases the version number by a full number (major version) or only increases 
the minor version where the major version number in the citation remains the same.  

 

☐ I re-checked my dataset and submitted it for review to AUSSDA for feedback if this is my 
first upload. 

☐ If all is well, I clicked publish. 
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Figure 17 Versioning of dataset in Dataverse. 

Deaccessioning of previous versions of published files should only be done by AUSSDA and is 
foreseen for legal reasons (e.g. violations of data protection or intellectual property rights) and 
requires an explanation and a justification.  

 

Take aways: Updates 

6. Checklist for the entire self-deposit process 
 

Legal questions (accreditation) 

☐ Get in contact with AUSSDA via info@aussda.at and attend the online training to become 
an accredited self-depositor. 

☐ Make sure you have taken a course on the basics of data protection in the last 12 months. 

☐ Get in contact with AUSSDA via info@aussda.at after attending the training course and 
sign the agreement that allows you to self-deposit data. 

☐ Understand the license agreements for data, metadata and documentation material. 

☐ Read and understand the AUSSDA Non-Compliance Policy. 

Preparing data and documentation material: GDPR compliance 

☐ I removed all direct identifiers from my data. 

☐ I checked all answers to open questions and removed personal or sensitive data, or deleted 
the variable(s). 
☐ I recoded standard demographic variables to broader categories if variables contain less 
than 20 observations for certain values and updated the codebook with these new categories. 

☐ I changed the versioning in the file names (in case I want to upload new files). 

☐ I published the Dataverse entry and decided on the nature of the version change (major vs. 
minor) in Dataverse. 

mailto:info@aussda.at
https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Self-deposit_Vertrag_SU_v1_1_de.pdf
https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Non-compliance_Policy.pdf
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Preparing data and documentation material: Data cleaning 

☐ I cleaned the data as suggested, e.g. regarding variable and value labels and missing 
values, among others. 
☐ I gathered all documentation material (questionnaires, codebooks, method report, 
anonymisation plan, ...) for my data. 
☐ I compared the data with the documentation material and checked if the variable names 
match. If not, I corrected all discrepancies. I checked for typos in the variable names and 
corrected them. 

☐ I double-checked the data with regard to plausibility and outliers and they are fine. 

Preparing data and documentation material: Documentation material 

☐ I double-checked if I have all mandatory documentation material. I also know which 
recommended documents I want to upload. 
☐ I included a suggested citation and information about the license of the document in each 
document, preferably on the first page. 

Create a Dataverse entry: Login 

☐ I logged into the AUSSDA Dataverse on https://data.aussda.at/. 

☐ I sent a message to info@aussda.at including my username so they can add me to the 
Self-Deposit Dataverse. 

Create a Dataverse entry 

☐ I navigated to the AUSSDA Self-Deposit Dataverse and started to add a new Dataverse 
entry by clicking on “+ Add Data“ > “New Dataset”. 

☐ I used the “Self-deposit (SUF terms) template to benefit from pre-filled fields. 

Create a Dataverse entry: Metadata 

☐ I collected all relevant metadata and saved the information in the AUSSDA metadata 
template. 
☐ I understand what controlled vocabularies are and selected the fitting terms for my 
dataset. 

☐ I entered all metadata in Dataverse. 

Create a Dataverse entry: DOI, version, file formats and file names 

☐ I added the variables “DOI” and “version” to my dataset. 

☐ I saved my documentation material as PDF/A. 

☐ I named my data files according to the AUSSDA file naming scheme. 

☐ I generated other file formats to increase the reuse potential. 

https://data.aussda.at/
mailto:info@aussda.at
https://data.aussda.at/dataverse/self-deposit
https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Metadata_v2_1.xlsx
https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Metadata_v2_1.xlsx
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Create a Dataverse entry: Upload files and file restrictions in Dataverse  

☐ I uploaded all data files in the recommended formats and documentation files in PDF/A. 

☐ I added a file path, description and tags to each file. 

☐ I restricted all my data files and confirmed that I can see a green, open lock next to the file 
name. 

☐ I checked the “Enable access request” checkbox for all data files. 

Create a Dataverse entry: Terms 

☐ I checked if the Terms of Use and Terms of Access are indeed pre-filled. 

☐ I checked if the number of restricted files corresponds to the number of data files. 

Create a Dataverse entry: Publishing 

☐ I re-checked my dataset and submitted it for review to AUSSDA for feedback if this is my 
first upload.   

☐ If all is well, I clicked publish. 

Create a Dataverse entry: Updates 

☐ I changed the versioning in the file names (in case I want to upload new files). 

☐ I published the Dataverse entry and decided on the nature of the version change (major vs. 
minor) in Dataverse. 
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